
SBJV Jpeg Viewer Help Contents
Jpeg Viewer main window commands:

File
New Jpeg Viewer
New Index Window
Generate Catalogs
Next Image
Previous Image
Encrypt File
Decrypt File
Open
Delete
Save as BMP
Set WallPaper
Print

Edit
Mark All
Mark None
Invert Marks
Mark Current File
UnMark Current File
Mark Wildcard
UnMark Wildcard

SlideShow
Start/Stop
Set Interval
Normal/WallPaper
Forward/Reverse/Random
Only include marked items

Image Properties
Auto-Color/Grayscale
Auto-ColorDepth/8-bit
Shrink/Fullsize/Stretch/Zoom
Center in Window

Options
Set decryption key
Display file/directory pane
Display categorization pane
Confirm Delete
Confirm Move
Next Picture Lookahead
Join Directories
Save Defaults

Help
Contents
About



New Jpeg Viewer
Creates another Jpeg viewer window. Useful if youd like to view more than one picture at a 
time. Both windows are completely independent and may view different directories if 
desired.



New Index Window
The visual index system is a feature designed to allow you to get a quick overview of the 
pictures in a particular directory. The visual index window displays a rectangular grid of 
thumbnail images which are generated automatically on-the-fly. You may scroll this grid up 
and down to get a view of the entire directory of images.

The visual index window can be opened in two ways: 1) with the New Index Window 
command on the Jpeg viewer main windows pull-down menu, and 2) with the Index button 
on the Jpeg viewer main window file/directory pane.

Double clicking on any thumbnail image will cause a full-size Jpeg viewer window to be 
opened.



Generate Catalogs
What are catalogs?

SBJV includes a catalog image generator. Catalog images are images that contain a 
collection of thumbnails. They are useful in case you wish to distribute a summary of your 
collection of images to another user. For example, catalogs are used widely in binary picture 
newsgroup to give an overview of a selection of pictures before they are uploaded. 
How do you generate them?
The option to generate catalogs is located under the File menu in the main window of SBJV. 
First go into the directory you wish to generate the catalogs from. Then, select Generate 
Catalogs from the file menu. You will be presented with a rather complex dialog box of 
options. Most of these are already set to the default values and need not be altered. Click on
Ok. Your catalogs will be placed in your SBJV/SBNews directory (unless you have specified 
otherwise). 
What are all those complicated options?
There are several options that control the output of the catalogs. Most are set to defaults 
and need not be modified. Here is a descriptive listing: 

Background Style
Blend Filename
Thumbnail Image Properties
Output File Path 
Output File Name
Cat-Number Padding
Initial Cat-Num
Output Image Size
Number of Columns/Rows
Quality

There is also a button called Annotate which will let you configure a header (text across the 
top of a page) and a footer (text across the bottom of a page) to be added to the catalogs. 
This is a good place to put a title or copyright information.



Quality
The quality setting effects the jpeg compression of the output catalog files. Setting normal 
quality yields good compression, but less than optimal image quality. Setting high quality 
enables very high image quality, but compression suffers and the output files will be larger 
than normal.



Background Style
This controls the background appearance of the catalogs (i.e. the area that is not covered by
the thumbnails). Several different styles are available depending on your personal 
preference. 

· Raised Groupbox / Sunken Groupbox. These simulate a 3-dimensional box around 
each image. The background color is automatically chosen to be light gray.

· Flat Gray / Flat Black / Flat White. These are pure colors.
· Tiled Blend of image. This takes another image (specified in the blend field) and tiles 

it for use as the background. The effect is similar to how MS-Windows can tile an 
image for wallpaper on your desktop.

· Stretched Blend of image. This takes another image (specified in the blend field) and 
stretches it to fill the background. Aspect ratio is not preserved, so some images may not 
look right in this perspective.



Blend Filename
This is the name of the file that will be blended into a background if you specified 
Tiled/Stretched blend as the background style above. Any JPG/GIF/BMP file will work.



Thumbnail Image Properties
This is a selection of miscellaneous properties for the thumbnail images.

· Center image in box. This causes each thumbnail image to be centered within its box 
rather than aligning it to the upper left corner.

· Fast integer scaling. Causes images to be scaled to a multiple of ½, ¼, or 1/8. The 
image will probably not fill the whole box in this case. You probably should NOT check
this option unless you have a good reason for doing so.



Output File Path
This specifies the path to which output files will be written. It defaults to the directory in 
which SBJV/SBNews was loaded.



Output File Name
This is the name of each catalog file. Do NOT specify a path or extention for the filename. 
The extention jpg will automatically be added. Catalog numbers will also be added 
automatically. 



Cat-Number padding
This controls how numbers are represented in the filename. This is best shown by 

example:

· No Padding: example cat1.jpg, cat2.jpg, ..., cat99.jpg
· Pad 2 digits: example cat01.jpg, cat02.jpg, ..., cat99.jpg
· Pad 3 digits: example cat001.jpg, cat002.jpg, ..., cat099.jpg
· Pad 4 digits: example cat0001.jpg, cat0002.jpg, ..., cat0099.jpg



Initial Cat-Num
This is the starting number for the catalog filenames. You can start it anywhere youd like, 
but 1 is usually a good bet.



Output Image Size
This specifies the resolution of the catalog files. You may choose anything you likelarger 
resolutions offer better quality and/or more images per page, but require a higher resolution 
display to view them fullsize. 800x600 or 1024x768 is usually a good choice.



Number of Rows/Columns
· Number of Columns. The number images across a page from left to right.

· Number of Rows. The number of images down a page from top to bottom.



Next/Previous Image
There are several ways to navigate through images in the Jpeg viewer:
· Use the Next Image or Previous Image command on the File pulldown menu.

· Scroll the file listbox and double-click on a filename. (assuming file/directory pane is 
open)
· Press the << or >> buttons. (assuming file/director pane is open)
· Press Control-N for next or Control-P for previous



Open File
Executing this command will present you with the Standard Windows File-Open dialog box. 
This may be useful if you know a specific file that you wish to view and you can find it more 
quickly this way rather than navigating through the Jpeg viewers file and directory listboxes.

The Open File dialog is a standard Windows common dialog box and should function similarly
to the Open File dialogs in other Windows programs that you are used to.

SBJV/Jview supports several different file formats.



Delete File

This command will delete the current image that you are viewing. The file will be deleted 
from your hard drive and will not be retrievable in the future. 

By default, a confirmation dialog will be presented to make sure that you wish to delete the 
file. You may disable this confirmation dialog by using the Confirm Delete preference on the 
options menu.



Save as BMP
This will save the current file that you are viewing as a Windows Bitmap (BMP) file. A dialog 
box will prompt you for the filename you wish to save it as. The BMP format is a useful 
format to use when communicating with other Windows programs.



File Types
SBJV/Jview supports the following file types:
· Jpeg (JPG): Jpeg is a lossy compression format. It uses a complex mathematical 

procedure to remove certain less-important information from the image. Thus, if an 
image that was originally not in the Jpeg format is converted to Jpeg, some loss of 
data will occur. However, this loss is calculated to be imperceptible to the human eye.
Since Jpeg is a lossy compression algorithm, it is able to achieve high compression 
ratios (i.e. small files) and is an excellent format for transmission to and from the 
internet.

· Windows Bitmap (BMP): The Windows Bitmap format typically does not employ any 
compression and hence may have a very large file size. The simplicity of the format 
makes it very easy for programs to use and it is widely supported by Windows 
programs.

· Graphics Interchange Format (GIF): The GIF format employs a lossless compression 
method, so no data is lost in the compression process. It is historically a very popular 
format, but recently has been losing much of its popularity to Jpeg. GIF is a good 
format to choose if you want your data compressed, but cannot afford to lose any 
data.



Set as Wallpaper
Executing this command will instruct Windows to set the current image as wallpaper. 
Wallpaper is the background of your desktop. SBJV/Jview will first convert the current image 
to a BMP, then save it in your SBJV/Jview directory as PAPER.BMP, and finally instruct 
Windows to use PAPER.BMP as wallpaper.

Thus, the file is actually copied and you may delete the original if desired.



Print
This will print the current image on your printer. There are two types of printing that can 

be performed:
1. Print at actual size: This will print the image to the printer at screen resolution. The 

image may be smaller (or larger!) than the paper and thus it might not fill the paper 
optimally. 

2. Print    scaled to paper: This will scale the image so that one axis of the image will will 
the entire page. This will use an optimal area of the paper, but it does have the effect
of magnifying very small images and they may appear pixelated.



Global Mark Commands: Mark All, Mark None, and Invert Marks

These three commands (Mark All, Mark None, and Invert Marks) all operate on the entire 
list of files. They do not depend on the current file that is hilighted in the listbox.

· Mark All: Sets every entry to marked status
· Mark None: Sets every entry to unmarked status
· Mark Invert: Anything that is marked will become unmarked, and everything that is 

unmarked will become marked.

Hint: You can use the Mark All command and the Delete command to delete an entire file 
directory with just a few keystrokes.



File Mark Commands: Mark Current File and Unmark Current File
These commands act on the file that is currently hilighted in the file listbox. They affect the 
marked status of that file only.



Wildcard Mark Commands: Mark Wildcard and Unmark Wildcard

These commands use a wildcard specification. A wildcard is a text string with the special 
characters * and ?. The * character will match any string of characters, and the ? character 
will match any single character. 

The Wildcard Mark commands will apply the wildcard string you enter to each filename in 
the filename list and mark each filename appropriately.

For example, if you used a*.jpg as your wildcard string, all Jpeg files beginning with the letter
a would be marked.



Slideshow General Information
The slideshow mode will display the pictures in a directory automatically, with each new 

picture being displayed at a fixed time interval. There are two ways to initiate a 
slideshow:

1. Use the Start/Stop menu item on the Slideshow pulldown menu.
2. Press the play > button on the file/directory pane.

Once a slideshow has been activated, there are two ways to stop it and return to normal 
mode:

1. Use the Start/Stop menu item on the Slideshow pulldown menu.
2. Press the stop o button on the file/directory pane. (The play button automatically 

changes to the stop button when the slideshow was started)

There are several different options that may be selected for the slideshow:

· Interval
· Normal/Wallpaper
· Forward/Reverse/Random
· Only include marked items

Hint: While the slideshow is playing, you may wish to hide the file/directory pane and/or the 
categorization pane to get a larger viewing field for the pictures. The panes may be hidden 
by using the Options pulldown menu.



Slideshow Interval
The interval is the amount of time that will elapse before the picture is changed to the new 
one. Setting a small interval will cause a fast slideshow and setting a large interval will cause
a slow slideshow. The interval may be changed before or during the slideshow presentation.



Slideshow: Normal vs Wallpaper Mode
The Normal mode will cause the slideshow pictures to be displayed in the Jpeg Viewer 
window. This is the default behaviour and should be suitable for most modes.

Wallpaper mode will cause your Windows wallpaper to be updated by the slideshow.

Hint: You could use Wallpaper mode, set a large interval, minimize the Jpeg viewer, and then
your Windows wallpaper would change automatically while you were working in other 
applications (kind of a slideshow in the background).



Slideshow: Forward, Reverse, or Random
This sets the order that the pictures will be displayed. Forward will display each picture 
successively moving down the directory. Reverse will display each picture moving up the 
directory. Random will choose each image at random (i.e. without any order whatsoever).



Slideshow: Only display marked items
This will limit the slideshow to items that you have marked with the mark commands 
(located under the edit menu). This may be useful if you would only like to include a subset 
of the files in the current directory in the slideshow.

Note that if no items are marked, this option will be ignored and all items will be displayed.



Automatic Color / Grayscale
These two options control whether images are displayed in color or grayscale (black and 
white). If Automatic Color is checked, then images will be displayed in color or grayscale 
depending on the type of the image. If Grayscale is checked, then the image will always be 
displayed in grayscale, regardless of the images color content.

Jpeg images can be decoded quicker in grayscale mode, since the color component need not
be decompressed. Thus, if you wish to quickly scan a series of images, you may wish to 
select grayscale decoding.



Automatic Color Depth / Forced 8-bit
Color depth is the amount of color information that is stored for each pixel. There are 

several different color depths available under the Windows operating system:
· 2-bit (monchrome): Only two colors, black and white.

· 4-bit: Sixteen colors, from an indexed palette
· 8-bit: 256 colors, from an indexed palette
· 16-bit: 65536 (or 32768 in some settings) colors.    True Color.
· 24-bit: 16 million colors. True Color.

Each successive color depth setting requires more memory (for uncompressed data). For 
example, a 24-bit image requires three times the storage space of an 8-bit image. 

Most people run their system in either 8-bit (256-color) or one of the True Color (16-bit, 24-
bit) modes. The Jpeg viewer will normally automatically determine what mode youre running
in and adjust its output accordingly. This is the Automatic Color Depth setting.

If you are running in one of the True Color modes and youd like the images to be processed 
in 8-bit mode, you can check the forced 8-bit option.



Shrink / Fullsize / Stretch
The Jpeg viewer supports several different methods of displaying the image on-screen:
· Shrink by Integer Scaling: This is the fastest method. The Jpeg decompression 

routines can automatically shrink an image to ½, ¼, or 1/8 scale. Shrunk images can 
be decompressed faster, so there is a noticeable speed gain. However, since the 
image is a fixed scale, it will probably not fill up the window, and will probably be 
smaller than you would like.

· Display full size: This will display the image at its full size resolution. The image may 
be larger than the available window space, and scrollbars will be enabled to let you 
pan or scroll the image around in the window.

· Stretch to Window: The image will be stretched so that it fills the largest possible 
area of the window while still preserving aspect ratio. If you have a very small image, 
then it may be stretched significantly beyond its true size. This method is comparably
slower than the others.

· Stretch to min(Window,Fullsize): Similar to the previous option, but it will not stretch 
an image beyond its real size. Thus, a very small image will remain very small. This 
may also be slow.\

· Zoom In (2:1, 3:1, ...): This will magnify the image as it appears onscreen. 



Center in Window

If checked, then the image will be centered in the window. If you dont check it, then the 
image will be aligned relative to the upper left corner.



Set Decryption Key
The Jpeg viewer may be configured to automatically decrypt files that have been encrypted 
with the Encrypt.Exe program or directly by SBNews/Newsbot. If an encrypted file is 
detected, then you will usually be prompted for the key, but you may also enter the key 
manually by selecting this option.



Display File/Directory Pane
If checked, then the file/directory pane will be displayed along the left side of the window. If 
unchecked, then it will not.

The file/directory pane contains a series of buttons and listboxes designed to allow you to 
easily navigate through a directory of images. Normally, you probably want to leave it 
enabled. However, if you want to maximize window room for the image (such as when 
running a slideshow), you may wish to disable it.



Display Categorization Pane
The categorization pane allows you to easily move files to other directories. It is displayed on
the right side of the main window. 



Confirm Delete
If checked, then a confirmation dialog will appear whenever you delete a file. This is helpful 
to keep you from accidentally deleting something you do not want to. However, if youre an 
expert user then you may wish to disable the confirmations.



Confirm Move
If checked, then a confirmation dialog will appear whenever you move a file using the 
categorization options. This is helpful to keep you from accidentally moving a file to the 
wrong directory. However, if youre an expert user then you may wish to disable the 
confirmations.



Next Picture Lookahead
The next picture lookahead will automatically begin preloading the next image when you 
start veiwing an image. Thus, if you are viewing images sequentially down a directory, this 
will speed things up. However, if you are not viewing images in a sequential manner (i.e. 
youre jumping all over the place for some reason), then this may slow things down.



Save Defaults
This will save the options that you have currently selected as defaults which will be used 
next time you load the program. 



Join Directories
This command is best illustrated by example... 

I routinely back up my image file collection to CD-R (writable CD-ROM drive) media to
save my more precious hard drive space. Thus, the bulk of the files are located on a CD-ROM
disc. Now, as I download new images, I categorize them into a directory on my hard drive 
(after all, I wouldn't want to burn a new CD every time I downloaded a new file). Thus, I have
two separate directory structures, one on CD and one on my hard drive.    To browse pictures,
I would normally have to switch between these two directories.

The join directories command was designed to deal with situations like this. It will allow you 
to join (or "merge") one physical directory into another, so you can see the files in more than
one directory at a time.

Following my example above,

I place files on my hard drive in a directory called D:\IMAGES. This directory has 
several subdirectories, such as D:\IMAGES\CARS, D:\IMAGES\PLANETS, etc. The CDR backup 
has an identical directory structure, on drive H:, H:\IMAGES\CARS, H:\IMAGES\PLANETS, etc.   
What I would like to be able to do is to merge these directories. 

I set up a join mapping in SBJV by setting source directory to D:\IMAGES\ and join 
directory to H:\IMAGES\. Now, any time I look at any picture in the D:\IMAGES\CARS\, the files
in H:\IMAGES\CARS\ will automatically be added to that directory. 

Specifically, this is what the join directories command does: Any time SBJV searches a 
directory for filenames, it will check to see if that directory matches any join source 
directories. If a source directory was matched, then the SBJV will also search the directory 
specified by the join directory.

For example, assume you set the following:
Source Directory = C:\PICTURES\DOGS
Join Directory = C:\PICTURES\COWS

Then, if you loaded up C:\PICTURES\DOGS, you would also see all of the pictures 
located in C:\PICTURES\COWS. Furthermore, if you loaded up C:\PICTURES\DOGS\
POODLES, then you would also get any pictures in C:\PICTURES\COWS\POODLES 
(unlikely, but possible). 

There are several uses for the join directories command:
· Merging the contents of directory structures located on different hard drives.
· Join the contents of several small directories into one large one. Good to display a

slideshow of ALL the pictures on your hard drive. 



Encrypt File
This command will allow you to encrypt a file so that it cannot be viewed without the 
encryption key. You may encrypt a single file or multiple files if you have some tagged. 

The encryption dialog will prompt you for an encryption key. This is the key that will be used 
to encrypt or "scramble" the image. You must remember this key if you are ever to view or 
decrypt the image again. A longer key does offer better protection against code breaking.

Once you have entered your key and pressed OK, a window will display the results as each 
file is encrypted. Once the encryption is complete, the OK button will be enabled and you 
may press it to dismiss the dialog.

SBJV, SB Image Explorer, and SBNews can all view encrypted files automatically, as long as 
you specify. Thus, you may encrypt your files for security while still being able to view them 
easily. You may use the decrypt command at any time to return your files to their original, 
unencrypted state.



Decrypt File
The decrypt command is used to decrypt or "unscramble" files that were encrypted using 
the encrypt command or Newsbot's automatic encryption features. Once decrypted, a file 
may be viewed by any program, with or without the encryption key.

The encryption dialog will prompt you for a key. This should be the same key that you used 
when you encrypted the file in the first place. You will be prompted to enter it twice, to make
sure that you typed it correctly. 

Once you have entered your key and pressed OK, a window will display the results as each 
file is decrypted. Once the decryption is complete, the OK button will be enabled and you 
may press it to dismiss the dialog.



Temporary Registration Code Expired
Your temporary registration code expired. My official policy (for Online Credit Card 
Registrations) is as follows:

1) You log on to my web site at http://smbaker.simplenet.com/sbnews/sbnews.html and press
the <Register> button. 

2) You are then guided through an online credit-card registration process.

3) When the process is completed, you are immediately issued a TEMPORARY registration 
code. This code is only good for a maximum of 7 days.

4) Usually within 72 hours of registering, you will receive via email a PERMANENT 
registration code keyed to the email name you supplied. You may then enter this code into 
SBNews and it will be good forever. You may discard the TEMPORARY code at this point.

If you have not received your PERMANENT registration code within the time period that the
TEMPORARY code has expired, then something has gone wrong. The email message may 
have been lost, or I may have somehow missed processing it. Please send an email 
immediately to smbaker@primenet.com and I will look into the situation and get back to 
you as soon as possible. 

Thank you for your support.




